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Introduction  

There's some great news… which is you don’t have to be super-

creative to produce your own unique product. You may always do 

what so many others do, and that's to upgrade something that exists; 

or make it greater and better it. You may produce a product mash-up 

and produce something over your own. Example, you've some 

particular issue or subject, and you have 3 or 4 eBooks on that issue.  

You may simply take ideas from all these eBooks and produce your 

own. You don’t copy but instead learning from them and making a 

product of your own that lets in your own ideas, analysis and data.  

The thing here is that you’re handling these research products as a 

commencing point to get ideas, so that it becomes simple for you to 

work with your own product. There’s an unbelievable number of ideas 

simply sitting all over the place, so do keep an awareness. If you’re 

going to build a product, then it’s in your best interest to make a high-

quality product holding useful info.  

Your first product, regardless of what you do, will always take the 

longest and feel like the hardest. Given here are hints that will help 

you in that field.  

 

 

 

 



Chapter 1: Take Care of these Most 

Critical Things for Writing an E-

book  

Synopsis  

There are a lot of advantages to writing eBooks, but the experience is 

priceless. Authoring something so involved is truly worth the time 

and effort, not simply for apportioning your knowledge, but for the 

feedback you get from those who read it.  

All the same, when most individuals begin to think about composing 

an entire eBook, they make the error of believing it will be 

complicated. The key component for success with any eBook is 

authoring it and presenting it the right way to your intended audience.  

  

 
What You Need To Know  

It's crucial to be centred if you wish to compose an eBook that will 

bring in cash. 



This is the most crucial thing about authoring a great eBook: don't let 

your attention wander from your goal as the more data that you are 

able to include in your eBook the greater it will be. For instance, if 

you're composing an eBook about “cat training” you have to stick to 

that matter and not attempt to cover everything about cats.  

If an individual chooses to purchase an eBook online, they're 

frequently looking for very directed info that may be utilized 

immediately. They don't wish to go through a whole bunch of frivolity 

before getting to the info they require.  

Additionally, bear in mind that the calibre of your eBook relies on how 

well you produce it. Among the chief reasons why publishers reject 

books again and again is because they're written poorly. So, if you 

wish to give your target audience something they'll like, along with 

great info, your presentation likewise matters.  

No one will give your eBook very much credit or even wish to read if 

it is not composed in a professional fashion. You have to really certain 

of what you write and how you're delivering it.  

Make certain that you're specific when you ask other people to review 

your eBook. Would you like review of your spelling and grammar? Or 

about the flux and the consistency? How about the calibre and 

usability of your info? You have to be extremely specific when you’re 

inviting feedback from individuals so that you know what precisely 

are the changes that you have to make. Remember, authoring a great 

eBook takes work and time and that means that you have to take the 

feedback you get to heart and put it to use.  



Platform  

“Platform” is the publishing hoopla for a plan that you've developed 

to market your eBook once you’ve released it. Your platform 

consolidates a number of tools to circulate the word about your new 

or newest eBook. As the responsibility for marketing your book is 

mostly your own, you're not only the writer; you're your own 

publisher, also. In and of itself, you're totally in charge of getting the 

word out to anybody you wish to purchase and read your eBook.  

As an eBook, published electronically for a likely readership that will 

get it, store it and read it is in an electronic data format, it stands to 

reason that you can reach that likely readership by electronic means.  

Here are a few of the things I've utilized to advertise my eBooks:  

Review Books  

Amazon and Barnes and Noble both enable me to provide a two-week 

lending of my book to a target area list of likely book reviewers 

associated with papers, magazines and blogs, who may help me to 

circulate the word about my eBook.  

Smashwords goes beyond that: by their unparalleled couponing 

program, they let me send net coupons to this same target market, 

who may issue an indifferent review of my eBook for their particular 

readership. My blended target market reviewers get through to a 

potential huge readership nationwide.   

  

  

  



Releases  

In order to accomplish my plan for book reviewer and book purchaser 

recruitment, I formulate numerous press releases tailored to each 

particular demographic or geographic section.  

Writer and Book Pages  

Each of my selected publishers provides me with a free writer page 

and a separate marketing page for each of my eBooks, which enable 

me to provide relevant info about my eBooks and my pertinent 

background, likewise links to my appropriate blogs and a chance to 

sample and (hopefully) sell my eBook.  

I utilize 2 of my blogs, to advertise any fresh developments about my 

eBooks. If you’re an author and/or a writer, I strongly advocate that 

you take up blogging. It’s an awesome way to express yourself on a 

steady basis, and it’s not as hard as you may believe. As a matter of 

fact, WordPress.com makes it really simple with stepwise tutorials 

and ready-made, neat and clean templates that take all the hard stuff 

out of it. Likewise, WordPress blogs tend to bear very few W3C 

Validation errors, which aids in maximizing SEO.  

Social Sites  

This is an area that I'm starting to develop for my marketing 

technique. Right now, I'm limiting myself to Facebook and LinkedIn. 

On Facebook, I’m acquiring better results, and I'm building more of a 

fan base of loved ones and acquaintances, and of acquaintances of 

acquaintances.  

Facebook enables me to issue news about my publishing efforts, full 

of images and direct links to particular posts on my blog.  



E-Mail Marketing  

In planning for advertising my eBooks, I acquired an extensive list 

of e-mail contacts, categorized into groups: loved ones, 

acquaintances, fellow publishers, paper editors, magazine editors, 

bloggers, book reviewers, and so forth. These sub-lists enabled me 

to tailor-make my promotional messages suitably to every group.  

Publish More Than A Single eBook  

Publish more than one eBook and publish a list of every one of your 

earlier eBook titles on the title page of every succeeding eBook that 

you publish.  

Utilize a Pro Cover Designer  

It's taken for granted that, particularly in the eBook publishing 

business, your cover picture sells your book. I'm exceedingly 

fortunate to have a designer who's a really talented and experienced 

family member who is a graphic designer. Even if you’re not so lucky, 

I advocate you do whatever it takes to get a pro digital front cover 

image for your eBook. You'll need it if you wish to publish on iPad and 

a few of the other major eReader formats.  

 

 

 

 

 

 



Chapter 2: Crafting the Best Topic 

for Your E-book  

Synopsis  

Sites target to better their popularity as this means larger earnings for 

them. If you own a site and are working on developing a product and 

are wondering how to better your popularity, then you ought to learn 

how to use keyword search right.  

Keywords are utilized to direct potential buyers to your site. The 

search engine rely one keywords and finds sites that have these 

keywords in their pages.  

But with a lot of words that are utilized daily, and 1000000s of 

potential buyers utilizing the web, how may you be assured that the 

keyword you chose will help you develop a popular product? How do 

you know that you're targeting the correct buyers? How may you 

return more income through picking the correct keyword search? 

Worry no longer. Here are helpful hints to help you attract potential 

buyers and develop a product.  

Getting The Product Ideas  

Your finest subject is forever a subject you've passion for, knowledge 

with and experience with. Your personal lifetime experiences have 

taught you an unparalleled set of lessons. Ascertain what you know 

that other people may determine as valuable.  

  

Naturally, you are able to make a small web site that centres on almost 

any matter you wish but you'll have a greater chance of success, 

particularly if this is your 1st web site or product, if you pick out a 



subject you have a little experience with. Additionally, it makes the 

procedure much more fun.  

Brainstorming  

Begin by brainstorming a list of issues. Get a pad and pen.  

What are you passionate about? Put it down. What do you like to 

discuss? What do you study about? What specified knowledge do you 

have from your line of work? Any spare-time activity? Begin writing. 

Put everything down…don’t exclude anything, simply put it down.  

List the ten greatest troubles you are able to think of in your 

household, work or community. What do you love doing with your 

free time?  

Ask your acquaintances and loved ones what they think you’re great 

at and intimate with. You may be amazed at the things they see that 

you’ve left out.  

Spend a strong thirty minutes on this brainstorming time. At first the 

thoughts will come rapidly. But then, after you’ve already put down 

the conspicuous ones, you’ll begin to have to truly think about it. This 

is when the true might of this exercise occurs.  

You see, the subconscious is an amusing thing. It takes a steady 

demand from your conscious mind to acquire its attention. But when 

you do, your subconscious mind will take up the effort for you and 

start to provide answers to your question as it comes up with them.  

  

By spending an undivided thirty minutes intensely centred on 

brainstorming issues for your product you transmit this demand to 

your subconscious. For the next week your subconscious will supply 

really creative topics for you in a sporadic and apparently random 



way. You’ll be driving, taking a shower or eating supper and abruptly 

you’ll get an awesome idea for a product.  

This strategy may be utilized for almost any question or dilemma. 

Simply remember the energy is in the results your subconscious 

produces in the days after doing the exercise. And that won’t occur if 

you don’t focus intensely on brainstorming issues for an undivided 

half-hour. It takes this long to be sure your subconscious gets your 

message.  

Creating Your Product  

To create your product, you have to do a couple of things right in order 

to get top results from your work and missing one of them may 

destroy your odds of being successful.  

1. Find an existing market  

You have to centre on a group of purchasers you are able to relate to 

and truly comprehend. A great target market is a group of individuals 

who share the same basic troubles, have cash to spend, and have a 

history of purchasing stuff related to the issue. When you detect such 

a group, they're willing to purchase.  

2. You have to discover what it is they already wish to purchase  

You ought to sell the particular things individuals wish to purchase. 

Never guess when producing net business ideas. Rather, research 

existing products and ask individuals directly what they're seeking.  

As soon as you know what it is your target market is following, you'll 

easily be able to produce your winning product rapidly and know for 

certain whether it will be fruitful.  



3. Produce a winning sales procedure  

As soon as you have your product theme prepared, it's time to issue a 

basic yet effective sales letter that demonstrates what advantages your 

buyers will get when they purchase from you. All you have to do is tell 

them precisely what troubles they'll solve, promise particular end 

results, and ultimately make them an offer that's too good to decline.  

4. You have to have targeted traffic  

Now that you've your sales machine ready, it's time to begin selling. 

Research where your buyers may be found and put your sales content 

in these places. If you are able to return at least $0.50 for every visitor, 

you have a success. You should then centre on reaching 1000s of 

individuals daily. If not, simply edit your sales presentation till it 

works better.  

5. You have to have an effective back-end design  

You have to maximize the lifespan value of every buyer. The first sale 

is simply to eliminate marketing costs. After that your true profits 

start. It's time to continually line up fresh offers that they wish to 

purchase from you. You are able to produce your own or make simple 

reseller deals with additional sellers. Simply make certain that you 

send a fresh offer at least once per month.  

  

  

Using Keywords  

Utilize Google.com  



Keyword selection plays a really vital role in your net business and 

product research. You always have to pick out keywords that attract 

likelier buyers. One really valuable tool to utilize is Google.com. 

Google has a keyword tool named Google AdWords’ Keyword tool. 

Begin your keyword search utilizing this link.  

adwords.google.com/select/KeywordTool external  

The aim here is to pay attention to keywords that are related to your 

product. When picking out, target words that contain “ready-buyers” 

or additional words or phrases that shows commercial intensions. 

Include the term “ready-buyer” or any additional associated term to 

your selected keyword that's related to your product. For instance, in 

keyword tool, type “sales course bestselling”.  

ClickBank.com net marketplace  

This site specializes in digital commodities and is really popular 

among net marketers. Explore keywords at  

clickbank.com/marketplace.htm.  

This site is really helpful, particularly if the products you provide 

relates to info, guide materials, or software. This isn't as popular as 

Google.com but is a great alternative to seek the better products and 

services sold.  

You've the option to search by product or by location. You may then 

narrow down search according to gravity, popularity, and the like.  

It's even more effective if you utilize this tool together with the gratis 

research tool provided by Google. Again, find terms or phrases that 

are akin to “ready=buyer” when searching keywords.  

 



Shopping.com search  

Once again, our target here is to seek keywords that are associated to 

“ready-buyers”. Commercial words are the sort of keywords we're 

seeking. Consequently, Shopping.com is an excellent tool to utilize 

when searching for the correct keyword.  

The finest way to detect likely buyers to find a good product online is 

to use the keywords that this site uses. Target keywords like clothes, 

accessories, books, and additional merchandise you may see on 

Shopping.com. If you want to offer one of these products, then this 

search engine is of big help to you. This is a really unique strategy that 

few people know.  

 

 

 

 

 

 

 

 

 

 

 

 

 



Chapter 3: Table Of Contents – 

Finalizing and Drafting  

Synopsis  

A table of contents, commonly headed merely "Contents" and shortened 

informally as TOC, is a list of the components of a book or document 

prepared in the order in which the pieces appear.  

The contents commonly include the titles or descriptions of the first 

level headers, like chapter titles in more tenacious works, and 

frequently includes second-level or section titles inside the chapters 

too, and sometimes even third-level titles.  

The depth of points in tables of contents depends upon the length of 

the work, with more tenacious works having less. Reports having 10 

or more pages and being too lengthy to put into a memo or letter 

likewise bear tables of contents.  

Documents of fewer than 10 pages don't call for tables of contents, but 

frequently have a curt list of contents at the start.  

How To Do It  

What is your unparalleled selling point? 1000s of would-be product 

makers are competing for your customers. What makes you so 

exceptional? Here's how to compose attention grabbing chapter titles 

so you stick out from the crowd.  

Discover as many search engines as you are able to and arrive at a list 

of the top searched terms for each one.  



Combine the lists, crossing out any duplicates. Designate classes to 

the top fifty most explored terms, like celebrities, research, finance, 

cash, love, romance, loved ones.  

When the terms have classes, attempt utilizing them to produce your 

unparalleled "selling" point in any chapter titles you compose in that 

class. A unique "selling" point supplies the reason readers ought to 

choose your eBook from the thousands of other resources they could 

read. As an author, you're selling yourself and your ideas both to your 

publisher and to your readers.  

Make it interesting.  

Look through the content you have already published. Which ones 

bear the most traffic? Discover recurring terms in those eBooks and 

equate them to your list of popular search terms.  

Talk to individuals you know. What subjects are they interested in this 

week, month, and year? Build a list of those issues.  

Listen to the radio, study daily papers, surf the net. What issues are 

being talked about? Which ones return the most intrigue or 

controversy?  

Utilizing the info, you've gathered, produce your chapter titles that 

correspond to your subject. As a product producer, you're selling your 

services as a writer as well as your subject. You'll need to produce a 

unique selling proposal, something about your eBook title as well as 

chapter titles that grabs the reader and makes him or her take note.  

Utilize emotion laden, particular, descriptive words in your titles.  

Utilize words and terms that make the reader ask questions.  



"How to Make celestial Au Gratin Potatoes" makes the reader wonder 

what is so celestial about them. Wonder alone will at least get them to 

click the link to your eBook.  

A few style manuals advocate keeping tables of contents under 3 pages 

so they may be surveyed easily. As they lack the alphabetical format 

that makes indexes so accessible, anything longer may become hard 

to  

scan.   

Automation for general word document.  

Constructing a table of contents for an eBook is an automatic process 

with great word-processing software. Here's how to produce a table 

of contents and update it as you compose in Microsoft Word, as well 

as how to utilize the table of contents to scroll through your written 

document.  

Make it a point that each embedded heading, if any, is in a 

discriminate paragraph by placing your cursor after the heading and 

pushing the "Enter" key.  

Employ Word's built-in heading or outline-level formatting styles to 

the headings you wish to include in the table of contents. If utilizing 

your own custom heading styles, pass over this step.  

Reveal paragraph marks after embedded headings by clicking on the 

"Show/Hide Paragraph Mark" toolbar button. Choose each paragraph 

mark, and then click "Font" on the "Format" menu. Click on the 

"Font" tab, select the "Hidden" check box and click on "OK." Hide the 

paragraph marks by clicking on the "Show/Hide Paragraph Mark" 

button once more. (If there are no embedded headings, skip over this 

step.)  



Put your cursor at the location in the written document where you 

wish to construct your table of contents and click on your left mouse 

button.  

Choose "Index and Tables" from the "Insert" menu, and then click on 

the "Table of Contents" tab.  

Click on "Options," if utilizing a custom heading style, and determine 

a style you applied to document headings below "Available styles." Put 

down a number for the level of heading you wish that style to be 

represented under "TOC level," to the right of the style name. 

Duplicate for every style you wish to include and click on "OK."  

Pick out a design listed below "Formats" or assign a custom layout. 

Pick out a tab leader (separator for the heading title and page number) 

from the "Tab Leader" drop-down list and the total of levels to reveal 

by clicking on the "Show Levels" arrows. Click "OK" to produce the 

table.  

Page Navigation With a TOC  

Scroll the written document to the table of contents.  

Point to a page number in your TOC. Your cursor will switch to a 

pointing hand.  

Click on the page number. The written document will scroll to that 

page.  

Updating the TOC  

Update the written document by appending, erasing or moving text.  

Click anyplace inside the TOC. The table text will turn grey.  

Push F9 to display the "Update Table of Contents" dialogue.  



Choose "Update Page Numbers only" and click on "OK." The grey 

around the table text will go away, and the numbers will be updated. 

Every format comes with its own default tab leader.  

Utilizing the table of contents in that fashion will display the Web 

toolbar, as the table of contents page numbers are inner hyperlinks. 

To push aside the Web toolbar, click its close button if it's a floating 

toolbar, or right-click it and deselect it on the shortcut menu if it's 

docked.  

Choosing the "Update Entire Table" selection in the "Update Table 

of Contents" box will reconstruct the default formatting of the table 

of contents format you picked out, eliminating any modifications 

you might have made.  

Word 2007  

Have you been tiresomely updating the TOC manually whenever you 

made an alteration to your eBook you were writing in Word 2007? 

Whether you have a written document already finished or are 

beginning a new one, a table of contents may easily and automatically 

be produced with MS Word 2007.  

Headings and subheads  

Determine which items you require named in the table of contents as 

well as their degree of importance. The degree of importance 

influences how the item will be formatted in the TOC. A main chapter 

head might be flush on the left margin. However, a subhead might 

appear indented below the chapter heading to demonstrate that it 

belongs to that certain chapter.  



Apply a heading 'style' to the points you wish listed in the table of 

contents. Styles are utilized to rapidly format any written document 

and likewise indicate which particulars will be included in the table of 

contents. For the function of producing a table of contents we wish to 

signal that a line of text is a heading so that it will come up in the table 

of contents. Open the styles menu from the Home tab on the toolbar 

or push ALT+CTRL+Shift+S on the keyboard. Highlight the text you 

wish listed and then click Heading 1 on the styles menu. The styles 

menu will stay open till you close it. Duplicate highlighting and 

clicking Heading 1 for the remainder of the text you wish included.  

Travel to the page in the document where you wish the TOC located. 

From the References tab on the toolbar, click Table of Contents. Click 

one of the Automatic table choices that comes out and a table of 

contents will generate and mechanically come up on the page. If you 

wish to include subheads, duplicate step two but specify the subhead 

text as Heading 2.  

  

  

  

  

  

  

  



Conclusion  

Online business is a great way for small business and entrepreneurs 

to operate. Remember you have to do some research when it comes 

to creating products, outsourcing work and getting and maintaining 

happy and loyal employees and business partners as well as 

customers.  

Hopefully this guide has put you well on your way to doing just that.  
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